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Preface

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and
documentation are constantly evolving to meet customer needs, so some actual dialogs
and/or tool descriptions may differ from those in this document. Please refer to our website
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each
page, in front of the page number. The numbering convention for the DS number is
“DSXXXXXXXXA”, where “XXXXXXXX” is the document number and “A” is the revision level
of the document.

For the most up-to-date information on development tools, see the MPLAB® IDE online help.
Select the Help menu, and then Topics to open a list of available online help files.

INTRODUCTION

This chapter contains general information that will be useful to know before using the
dsPIC33C Touch-CAN-LIN Curiosity Development Board. Items discussed in this
chapter include:

* Document Layout

» Conventions Used in this Guide

* Recommended Reading

* The Microchip Website

* Product Change Notification Service

» Customer Support

* Document Revision History

DOCUMENT LAYOUT

This user’s guide provides an overview of the dsPIC33C Touch-CAN-LIN Curiosity
Development Board. The document is organized as follows:

» Chapter 1. “Overview” — This chapter introduces the dsPIC33C Touch-CAN-LIN
Curiosity Development Board and provides a brief overview of its various
features.

» Chapter 2. “Hardware” — This chapter describes how to program/debug the
board using the on-board programmer and the main circuit elements of the board.

» Appendix A. “Board Layout and Schematics” — This appendix provides
schematic diagrams for the dsPIC33C Touch-CAN-LIN Curiosity Development
Board.

* Appendix B. “Bill of Materials (BOM)” — This appendix provides the component
list used in assembling the board.

© 2023 Microchip Technology Inc. and its subsidiaries DS70005531A-page 5
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CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS

Description

| Represents

Examples

Arial font:

Italic characters

Referenced books

MPLAB® IDE User’s Guide

Emphasized text

...Is the only compiler...

Initial caps A window the Output window
A dialog the Settings dialog
A menu selection select Enable Programmer
Quotes A field name in a window or | “Save project before build”
dialog
Underlined, italic text with A menu path File>Save
right angle bracket
Bold characters A dialog button Click OK

Atab

Click the Power tab

N‘Rnnnn

A number in verilog format,
where N is the total number of
digits, Ris theradixand nis a
digit.

4'b0010, 2'hF1

Text in angle brackets < >

A key on the keyboard

Press <Enter>, <F1>

Courier New font:

Plain Courier New

Sample source code

#define START

Filenames autoexec.bat

File paths c:\mccl18\h

Keywords _asm, _endasm, static
Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants O0xFF, ‘A’

Italic Courier New

A variable argument

file.o, where file can be
any valid filename

Square brackets [ ]

Optional arguments

mccl8 [options] file

[options]

Curly brackets and pipe
character: { | }

Choice of mutually exclusive
arguments; an OR selection

errorlevel {0]1}

Ellipses...

Replaces repeated text

var name [,
var name...]

Represents code supplied by
user

void main (void)

{
}

DS70005531A-page 6
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Preface

RECOMMENDED READING

This user’s guide describes how to use the dsPIC33C Touch-CAN-LIN Curiosity
Development Board. The device-specific data sheets contain current information on
programming the specific microcontroller or Digital Signal Controller (DSC) devices.
The following Microchip documents are recommended as supplemental reference
resources:

MPLAB® XC16 C Compiler User’s Guide (DS50002071)

This comprehensive guide describes the usage, operation and features of Microchip’s
MPLAB XC16 C compiler (formerly MPLAB C30) for use with 16-bit devices.

MPLAB® X IDE User’s Guide (DS50002027)

This document describes the installation and implementation of the MPLAB X IDE
software.

dsPIC33CK1024MP710 Family Data Sheet (DS70005496)

Refer to this document for detailed information on the dsPIC33CK single core Digital
Signal Controllers (DSCs). Reference information found in this data sheet includes:

» Device memory maps
* Device pinout and packaging details
* Device electrical specifications

» List of peripherals that are included on the devices and are available for download
from the Microchip website (www.microchip.com).

THE MICROCHIP WEBSITE

Microchip provides online support via our website at www.microchip.com. This website
is used as a means to make files and information easily available to customers.
Accessible by using your favorite Internet browser, the website contains the following
information:

* Product Support — Data sheets and errata, application notes and sample
programs, design resources, user’'s guides and hardware support documents,
latest software releases and archived software

* General Technical Support — Frequently Asked Questions (FAQs), technical
support requests, online discussion groups, and Microchip consultant program
member listing

* Business of Microchip — Product selector and ordering guides, latest Microchip
press releases, listing of seminars and events, listings of Microchip sales offices,
distributors and factory representatives

PRODUCT CHANGE NOTIFICATION SERVICE

Microchip’s customer notification service helps keep customers current on Microchip
products. Subscribers will receive e-mail notification whenever there are changes,
updates, revisions or errata related to a specified product family or development tool of
interest.

To register, access the Microchip website at www.microchip.com, click on Product
Change Notification and follow the registration instructions.

© 2023 Microchip Technology Inc. and its subsidiaries Advance Information DS70005531A-page 7
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CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

« Distributor or Representative

* Local Sales Office

» Corporate Application Engineer (CAE)
+ Embedded Solutions Engineer (ESE)

Customers should contact their distributor, representative or Embedded Solutions
Engineer (ESE) for support. Local sales offices are also available to help customers.
A listing of sales offices and locations is included in the back of this document.

Technical support is available through the website at:
http://www.microchip.com/support.

DOCUMENT REVISION HISTORY

Revision A (April 2023)
This is the initial release of this document.

DS70005531A-page 8 © 2023 Microchip Technology Inc. and its subsidiaries
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Chapter 1. Overview

1.1 INTRODUCTION

The dsPIC33C Touch-CAN-LIN Curiosity Development Board (EV97A97U) is intended
as a feature-rich development and demonstration platform to enable customers to
explore Touch, CAN/CAN-FD and LIN communication on dsPIC33C DSCs. In addition,
the board supports mikroBUS™ and XPLAINED PRO interfaces, allowing companion
development boards such as ATECC608/TA100 secure elements, QT Touch extension
boards, BIST XPRO extension kits for pin failures, various sensors and interfaces via
Click Boards™ to be used. Information for supported companion boards is available
through the website at: www.microchip.com/en-us/development-tool/EVI7U97A.

The main hardware features of the board are highlighted in Figure 1-1.

FIGURE 1-1: dsPIC33C CURIOSITY DEVELOPMENT BOARD

@Mlcnncmp
iIsPIC33C Touch CAN LIN
2 uriosity Developmext Board e. .J

EV97U97A

L X n -

1. 1SO 26262 compliant dsPIC33CK1024MP710 single core Digital Signal
Controller (DSC) target device

2. Integrated PICkit™ On-Board 4 (PKOB4) programmer/debugger

3. 2xmikroBUS™ interfaces for hardware expansion, compatible with a wide range
of existing Click boards™ from MikroElektronika (www.mikroe.com)

1x Red/Green/Blue (RGB) LED

3x general purpose push buttons

5x general purpose green indicator LEDs
MCLR Reset push button

10 kOhm potentiometer

2 Xplained Pro Extension Headers

© 2023 Microchip Technology Inc. and its subsidiaries Advance Information DS70005531A-page 9
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10. 3 voltage sensing circuits (VBAT sense, 5V sense, and VREF)
11. 3 on-board capacitive touch pads

12. 3x6 100 mil male header to select between on-board capacitive touch pads or
the Xplained Pro Extension header #2

13. 2x5 100 mil male jumper to provide multiple choices for conversion of analog
channels 20 and 21

14. Functional Safety Safe LED circuit
15. SENT Diriver circuit

16. CAN/CAN-FD Diriver circuit

17. LIN Driver circuit

18. 2 Channel USB Hub supporting PKOB4 programming and UART/COM channel
simultaneously

19. 1x3 pin 100 mil male header to select between 5V external or 5V USB power
20. 5V to 3.3V LDO

DS70005531A-page 10 Advance Information  ©2023 Microchip Technology Inc. and its subsidiar-
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Chapter 2. Hardware

21 POWERING THE BOARD

Choose between USB or external power via the 3-pin header J6 by shunting 2 pins
together.

2141 USB Power

This board is intended to be primarily powered from the USB Micro-B connector, J1.
The official “USB 2.0 Specification” restricts USB applications to consuming no more
than 500 mA of USB VBUS power from the host. USB power must always be provided
to the board and is the primary 5V source.

21.2 External Power

An external +5V VDC may optionally be connected through pin 2 of the J5 connector.
Care should be taken to avoid exceeding a maximum of 6V on this input or damage to
the 3V3 LDO may occur.

2.2 USING THE PROGRAMMED DEMO FIRMWARE

The development board comes programmed with basic demo firmware, which
exercises several of the board hardware features. The potentiometer can be used to
adjust the voltage, and the analog reading will be output via UART through the USB
connector. The capacitive touch pads will light up when pressed. Sliding a finger from
left to right on the touch pads will show the five lights turning on in the sequence in
which the pads are touched. Additionally, the touch position information is output via
UART.

The source code for the demo can be obtained from:
www.microchip.com/en-us/development-tool/EVO7U97A

2.3 REPROGRAMMING AND DEBUGGING THE dsPIC33CK1024MP710 DEVICE

The board has a PICkit™ On-Board (PKOB4) programmer/debugger circuit, which can
be used to program and debug the dsPIC33CK1024MP710 target device (U1).
Alternatively, an external programmer/debugger tool can be connected to the board via
the 6-pin in-line connector J4 using a male-male 100 mil pitch 6-pin header.

© 2023 Microchip Technology Inc. and its subsidiaries Advance Information DS70005531A-page 11
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The PKOB4 circuit should automatically enumerate and be recognized by the
MPLAB® X IDE, v5.05 or later, when the dsPIC33C Touch-CAN-LIN Curiosity
Development Board is connected to the host via the USB Micro-B connector, J1. No
custom USB driver installation is necessary as the PKOB circuit relies on standard OS
provided Human Interface Device (HID) drivers; therefore, the driver installation should
be fully automatic. When plugged in, the PKOB programmer/debugger tool can be
selected from the MPLAB X project properties page by selecting the device under:
Hardware Tools>Microchip Kits>Starter Kits (PKOB)>Curiosity/Starter Kits (PKOB4),
as shown in Figure 2-1.

FIGURE 2-1: dsPIC33C CURIOSITY PKOB TOOL SELECTION
h m Project Properties - Curio_Test_Code e
i Categories: Configuration
e O General Family: Device:
i@ File Indusion/Exclusion All Families «|  |dsPIc3ackiozamMPTI0 v
= @ Conf: [default]
we @ PKoB4 Connected Hardware Tool: Supported Debug Header:
e Loading Curiosity/Starter Kits (PKOB4)-SM:TCHO00002004 | [ ] Show All None
o @ Libraries
@ Building
5@ XC18
i @ ¥C16 (Global Options)
@ wclé-as
@ xclé-goo
@ xcle-d
@ xclé-ar
------ @ Analysis

Manage Configurations...

Manage MNetwork Tools. ..

Compiler Toolchain:
l C16 (v2.00) [C:\Program Files\Microchip\xc 161w 2.00'bin]

Cancel Apply Unlock Help

2.4 USING THE USB-UART INTERFACE

Two USB-UART channels are available for communication from the dsPIC device to a
PC via the USB connector. The MCP2221A provides the first channel, and the PKOB4
provides the second. Each channel will enumerate separately and can be used
simultaneously.

241 MCP2221A based USB-UART Channel

The board is equipped with a USB-UART interface based around the MCP2221A chip.
The MCP2221A chip implements the standard Communication Device Class (CDC) —
Abstract Control Model (ACM) protocol, and therefore, can use standard USB drivers
that are provided with modern Windows®, Mac® and Linux® operating systems. Under
most operating systems, the USB driver installation will be fully automatic. Under
certain older operating systems, or if the device is attached to a machine running an
operating system older than Windows 10 without an active Internet connection, manual
installation of the drivers may be necessary. In this case, the driver package can be
downloaded from:

DS70005531A-page 12
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Details on how to access the serial port from Mac and Linux operating systems can also
be found in the associated collateral for the MCP2221A. Under Windows, after
successful USB driver installation, the device will appear as a “COMXx” port object,
which standard serial terminal programs can open/read/write to and from.

2.4.2 PKOB4 based USB-UART Channel

Since this board has a 2-port USB hub, it can support more than one COM channel at
a time. The second COM channel is connected through the PKOB4 directly to the USB
connector allowing two unique UART interfaces to be utilized from the dsPIC.

To utilize this interface, configure a UART connection to nets RP99_RA8 PKOB_TX
and RP45_RB13_PKOB_RX. All nets are named assuming the perspective of the
dsPIC device; the UART TX pin should be RP99 while the UART RX pin should be
RP45.

© 2023 Microchip Technology Inc. and its subsidiaries DS70005531A-page 13
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2.5 CIRCUIT DETAILS

This section highlights some of the circuit elements and provides an explanation for
their intent and function.

TABLE 2-1:

JUMPERS/HEADERS/CONNECTORS

Jumper/
Header/
Connector

Description

J1

Micro B USB connector. Used as a 5V power source for the board, PKOB
programming and COM ports.

J2

Unpopulated 2-pin 50 mil header used to erase the PKOB4.

J3

Unpopulated 8-pin header used to program the PKOB4.

Ja

Unpopulated 6-pin staggered header interface that can be used optionally to
connect an external programmer/debugger to the target microcontroller, U1. The
J4 header connects to the debug port, PGx3. The holes are slightly staggered to
provide some friction retention force without requiring physical soldering when a
straight male-male or right angle male-male header is installed into J4.

J5

2-pin header used to provide 5V external power. Do not exceed a maximum
input voltage of 6V or damage to the 3V3 LDO may occur.

J7

Unpopulated 4-pin terminal header as an optional substitute to the standard
CAN driver header (J11) that is on the board.

J8

2-pin header used to provide access to the dedicated analog channel 0. Shunt
the header to connect analog channel 0 to the potentiometer.

J9, J10

Headers used for Mikrobus Click A and B respectively.

J1

DE-9P Male connector used as the output of the CAN Driver circuit.

J12

3-pin header used to allow fault injection into the potentiometer circuit. Shunting
the 3v3 pin to the middle will drive the line high, while shunting to the GND side
will drive the line low.

J13

2-pin 100 mil header that can be used for a 5V pull up on the SENT Driver line.

J14, J15

Xplained Pro Extension Interface headers used to connect to a variety of
boards.

J16

1x3 terminal header used as the SENT Driver interface.

J17

2x5 pin header used to determine where analog channels 20 and 21 will con-
nect. Each channel can be shunted to three different pins to measure separate
circuits. See Section 2.5.2 “AN20/AN21 Connection” for more information.

J18

2-pin header that can be used to measure the current consumed only by the
dsPIC. The net tie trace must be cut on the bottom before measurements can
be taken.

J19

3x6 connector used to determine whether each analog channel is connected to
the capacitive touch pads or the EXT2 header. In Figure 2-5, all six channels
are connected to the capacitive touch pads, enabling redundant measurement
on each pad. Alternatively, all six channels can be connected to the EXT2 header
to enable support for Xplained Pro Extension boards.

J20

3-pin header which allows the LIN_BUS line to be pulled up either via the INH
line or the LIN_VSi line depending on where a 2-pin shunt is placed.

J21

Unpopulated 2-pin header that can be used to tap into the UART traces
connected to the PKOB4 chip.

J22

3-pin terminal header that acts as the output connection for the LIN Driver
circuit

DS70005531A-page 14
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251 User Interface (Ul)

The dsPIC33C Touch-CAN-LIN Curiosity Development Board contains a User
Interface (Ul) that is easily accessible on the right side (see Figure 1-1). The Ul has the
following elements:

* One RGB LED

* A 10 kOhm potentiometer

* Three push buttons

 Five indication LEDs

* Three capacitive touch pads

Each element can be programed for any purpose to create the desired interaction
between the user and the board behavior.

2.5.2 AN20/AN21 Connection

Both channel AN20 and AN21 have three possible shunt options. If both mikroBUS
click boards are used, AN20 and AN21 can be shunted to click A Analog and click B
Analog, respectively (Figure 2-2).

FIGURE 2-2: AN20/AN21 CONNECTION

AN

PKOB_RX

ClickB AN

Alternatively, three voltage sense circuits can also be connected. The VBAT sense
circuit that can be shunted to AN20 is used to measure the LIN input voltage through a
voltage divider to maintain the 3v3 tolerance on AN20. The 5V sense can be connected
to AN21 where 5V is divided down to 2.5V to maintain 3v3 tolerance on AN21

(Figure 2-3).

FIGURE 2-3: SENSE CIRCUIT

g prd
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The VREF pin is a 2v5 output voltage reference option. Since the VREF pin is in
between AN20 and AN21, either can be chosen (Figure 2-4).
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253 Capacitive Touch and Extension Header 2

The out-of-box jumper configuration allows each capacitive touch pad to be read
redundantly from two analog channels (Figure 2-5). For functionality purposes, only
one out of each pair is necessary to measure the touch pad.

FIGURE 2-5: CAPACITIVE TOUCH PADS

lEDS R114
|pn-a-»
LED1O R115
In o@m
LED11 R116
| -4 e

To use an Xplained Pro device that requires two extension header connections, the
jumpers should be moved from the ANx row and touch row on the J19 connector to the
EXT2 row and ANx as shown in Figure 2-6.

FIGURE 2-6: EXTENSION HEADER CONNECTIONS

DS70005531A-page 16 © 2023 Microchip Technology Inc. and its subsidiaries
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Appendix A. Board Layout and Schematics

This appendix contains the pinout, the schematics and the board layouts for the
dsPIC33C Touch-CAN-LIN Curiosity Development Board. The topics covered in this

appendix include:
* Pinout

» dsPIC33C Touch-CAN-LIN Curiosity Development Board Schematics
» dsPIC33C Touch-CAN-LIN Curiosity Development Board PCB Layout

A1 PINOUT

Table A-1 shows the pinout and corresponding function for the dsPIC33C device.

TABLE A-1:  PINOUT AND ELECTRICAL PARAMETERS, J1

Name dsPIC® DSC Pin Function/Description
RP46_RB14 1 UART TX to USB
AN20_REO 2 J17 Analog Options
RP47_RB15 3 UART RX from USB
AN21_RE1 4 J17 Analog Options
RP80_RFO 5 LIN RXD
RP60_RC12 6 LIN EN
RP61_RC13 7 LIN TXD
RP62_RC14 8 CAN RXD
RP63_RC15 9 CAN TXD
MCLR 10 Master Clear
RP79_RD15 11 CAN STBY
RP81_RF1 12 SENT Driver
GND 13 Digital Ground
dsPIC3V3 14 Digital Power
RD14_SLED_ON_OFF 15 FuSa SAFE LED
RD13_SW1 16 Switch 1
AN12_RCO 17 J19 Analog Options
ANO_RAO 18 Potentiometer
AN22_RE2 19 J19 Analog Options
RF2_SLED_SAFE 20 FuSa SAFE LED
NC 21 Not Connected
AN23 RE3 22 J19 Analog Options
RF3_Sw2 23 Switch 2
AN9_RA2 24 J19 Analog Options
RF4_SW3 25 Switch 3
RF5_SHIELD 26 mTouch Shield
AN3_RA3 27 J19 Analog Options
NC 28 No Connection

© 2023 Microchip Technology Inc. and its subsidiaries Advance Information
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dsPIC33C Touch-CAN-LIN Curiosity Development Board User’s Guide

TABLE A-1:  PINOUT AND ELECTRICAL PARAMETERS, J1 (CONTINUED)

Name dsPIC® DSC Pin Function/Description
AN24 RP86_RF6 29 J19 Analog Options
AN4_RA4 30 Xplained Pro 2
NC 31 No Connection
AN25_RF7 32 Xplained Pro 2
dsPIC3V3 33 Analog Power
GND 34 Analog Ground
NC 35 No Connection
AN13_RC1 36 Xplained Pro 2
AN14_RC2 37 Xplained Pro 2
AN17_RC6 38 Xplained Pro 2
dsPIC3V3 39 Digital Power
GND 40 Digital Ground
AN15_RC3 41 Xplained Pro 2
CLKI_AN5_RBO 42 MEMS Clock In
AN6_RB1 43 Xplained Pro 1
AN19_RD11 44 Xplained Pro 1
RE6_LED1 45 mTouch LED
AN26_RF8 46 Xplained Pro 1
AN18_RD10 47 Xplained Pro 1
RE7_LED2 48 mTouch LED
RP89 RF9 49 Xplained Pro 1
AN16_RC7 50 Xplained Pro 1
AN1_AN7_RB2 51 Xplained Pro 1
RE8_LED3 52 mTouch LED
RP90_RF10 53 Xplained Pro 1
AN8_RB3 54 Xplained Pro 1
RE9_LED4 55 mTouch LED
RP91_RF11_LED5 56 mTouch LED
RP36_RB4 57 Xplained Pro 2
ASDA1_RC8 58 Xplained Pro 1, 2 SDA
ASCL1_RC9 59 Xplained Pro 1, 2 SCL
RP92_RF12 60 Xplained Pro 2
RP73_RD9 61 Xplained Pro 1
RP72_RD8 62 Xplained Pro 1
GND 63 Digital Ground
dsPIC3V3 64 Digital Power
RP71_RD7 65 Touch ID chip
NC 66 No Connection
NC 67 No Connection
PGD3_RB5 68 PGD
PGC3_RB6 69 PGC
RE10 70 Click B INT
RP93_RF13 71 Click B TX
AN2_AN30_RB7 72 Xplained Pro 1

DS70005531A-page 18
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Board Layout and Schematics

TABLE A-1:  PINOUT AND ELECTRICAL PARAMETERS, J1 (CONTINUED)

Name dsPIC® DSC Pin Function/Description
RE11 73 Click B RST
RP94_RF14 74
AN10_RB10 75 Xplained Pro 1
RP95_RF15 76
AN11_RB9 77 Xplained Pro 1
NC 78 No Connection
RP96_RA5 79 Click A, B SCK
PWM5H_RC4 80 Click B PWM
NC 81 No Connection
RP53 RC5 82 Click A, B MISO
PWM7H_RC10 83 Click APWM
RP59_RC11 84 Click A, B MOSI
ASDA3_RD4 85 Click A, B SDA
ASCL3_RD3 86 Click A, B SCL
GND 87 Digital Ground
dsPIC3V3 88 Digital Power
RP66_RD2 89
RP65_PWM4H_RD1 90 RGB LED (Blue)
RP64_RDO 91
RP42_PWM3H_RB10 92 RGB LED (Green)
RP43_RB11 93
RE14 94
RP97_RA6 95
NC 96 No Connection
RP44_PWM2H_RB12 97 RGB LED (Red)
RE15_LIN_WKIN 98
RP99_RA8_PKOB_TX 99 UART TX to PKOB
RP45_RB13_PKOB_RX 100 UART RX from PKOB

© 2023 Microchip Technology Inc. and its subsidiaries
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A.2

Figure A-1 through Figure A-8 show the board schematics.

FIGURE A-1:

dsPIC33C TOUCH-CAN-LIN CURIOSITY DEVELOPMENT BOARD SCHEMATICS

dsPIC33C TOUCH-CAN-LIN CURIOSITY DEVELOPMENT BOARD SCHEMATICS, REV. 3.0 (PAGE 1 OF 9)
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FIGURE A-2:

dsPIC33C TOUCH-CAN-LIN CURIOSITY DEVELOPMENT BOARD SCHEMATICS, REV. 2.0 (PAGE 2 OF 9)
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FIGURE A-3: dsPIC33C TOUCH-CAN-LIN CURIOSITY DEVELOPMENT BOARD SCHEMATICS, REV. 2.0 (PAGE 3 OF 9)
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FIGURE A-4: dsPIC33C TOUCH-CAN-LIN CURIOSITY DEVELOPMENT BOARD SCHEMATICS, REV. 2.0 (PAGE 4 OF 9)
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FIGURE A-5: dsPIC33C TOUCH-CAN-LIN CURIOSITY DEVELOPMENT BOARD SCHEMATICS, REV. 2.0 (PAGE 5 OF 9)
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FIGURE A-6:

dsPIC33C TOUCH-CAN-LIN CURIOSITY DEVELOPMENT BOARD SCHEMATICS, REV. 2.0 (PAGE 6 OF 9)
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FIGURE A-7:

dsPIC33C TOUCH-CAN-LIN CURIOSITY DEVELOPMENT BOARD SCHEMATICS, REV. 2.0 (PAGE 7 OF 9)
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Board Layout and Schematics

A.3 dsPIC33C TOUCH-CAN-LIN CURIOSITY DEVELOPMENT BOARD PCB
LAYOUT

The dsPIC33C Touch-CAN-LIN Curiosity Development Board is a four-layer FR4, 1.6 mm,
Plated-Through-Hole (PTH) PCB construction. Figure A-10 and Figure A-11 illustrate the PCB layers.

FIGURE A-10: dsPIC33C TOUCH-CAN-LIN CURIOSITY DEVELOPMENT BOARD TOP SILKSCREEN
AND TOP COPPER
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FIGURE A-11: dsPIC33C TOUCH-CAN-LIN CURIOSITY DEVELOPMENT BOARD BOTTOM
SILKSCREEN AND BOTTOM COPPER
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dsPIC33C TOUCH-CAN-LIN
CURIOSITY DEVELOPMENT
BOARD USER’S GUIDE

Appendix B. Bill of Materials (BOM)

This appendix contains the Bill of Materials (BOMs) for the dsPIC33C Touch-CAN-LIN

Curiosity Development Board.
* Bill of Materials—dsPIC33C Touch-CAN-LIN Curiosity Development Board

B.1 BILL OF MATERIALS—-dsPIC33C TOUCH-CAN-LIN CURIOSITY
DEVELOPMENT BOARD
Table B-1 shows the Bill of Materials for the dsPIC33C Touch-CAN-LIN Curiosity
Development Board.
TABLE B-1: dsPIC33C TOUCH-CAN-LIN DEVELOPMENT BOARD BOM
. . L. Manufacturer Part
Qty Designator Description Manufacturer Number
11 | _J1,.J8, _J13, _J17, |MECH HW JUMPER 2.54mm | Tyco Electronics 382811-6
_J18,_J19, J20, J21, |1x2 (TE Connectivity)
_J22, J23, J24
20 |C1,C4,C6,C9,C10, |CAPCERO.1uF 16V 10% X5R | Murata GRMO033R61C104KE84D
C11,C12,C14,C15, |SMD 0201
C18, C19, C20, C21,
C22, C23, C24, C25,
C26, C28, C29
1 C2 CAP CER 10uF 25V 10% X5R | Murata GRM21BR61E106KA73L
SMD 0805
1 C3 CAP CER 0.022uF 16V 10% | Samsung Electro- CL05B223KO5NNNC
X7R SMD 0402 Mechanics
6 C5, C8, C16, C17, CAP CER 4.7uF 16V 10% X5R | TDK Corporation C1608X5R1C475K080A
C34, C68 SMD 0603 C
1 Cc7 CAP CER 1000pF 50V 10% Murata GCM155R71H102KA37D
X7R SMD 0402
1 C13 CAP CER 10000pF 16V 10% |KEMET C0402C103K4RACTU
X7R SMD 0402
3 C27,C42, C57 CAP CER 10uF 10V 20% X5R | Samsung CL10A106MP8NNNC
SMD 0603
19 |C30,C31, C32, C33, CAP CER 0.1uF 16V 10% X7R | Murata, KEMET GRM155R71C104-
C38,C39, C45, C53, SMD 0402 KA88D,
C54, C55, C56, C58, C0402C104K4RA-
C60, C61, C62, CAUTO
C63,C65,C66,C112
1 C40 CAP CER 470pF 50V 10% Samsung Electro- CL10B471KBS8NNNC
X7R SMD 0603 Mechanics
3 C43, C44, C75 CAP CER 0.1uF 50V 10% X7R | Yageo CCO0603KRX7R9BB104
SMD 0603
1 C46 CAP CER 1000pF 50V 10% D3_AVX Corporation 08055C102KAT2A
X7R SMD 0805

© 2023 Microchip Technology Inc. and its subsidiaries Advance Information
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TABLE B-1: dsPIC33C TOUCH-CAN-LIN DEVELOPMENT BOARD BOM (CONTINUED)
1 Cc4a7 CAP CER 220pF 100V 5% KEMET C0603C221J1GACTU
COG, NP0 SMD 0603
4 C48, C51, C52, C73 CAP CER 0.1uF 50V 10% X7R | D3_AVX Corporation 08055C104KAT2A
SMD 0805
1 C49 CAP TANT 22uF 16V 10% AVX TAJB226K016RNJ
2.3RSMD B
1 C59 CAP TANT 22uF 25V 10% KEMET T491D226K025AT
0.80hm SMD D
4 C64, C76, C77,C78 CAP CER 1uF 10V 10% X5R | Samsung Electro- CLO5A105KP5NNNC
SMD 0402 Mechanics
1 ce7 CAP CER 1000pF 50V 10% TDK Corporation C1608X7R1H102K
X7R SMD 0603
1 C70 CAP CER 4700pF 100V 10% | TDK Corporation CGA3E2X7R2A472K080
X7R SMD 0603 AEC-Q200 AA
1 C74 CAP CER 330pF 50V 10% Yageo CC0805KRX7R9BB331
X7R SMD 0805
1 CS1 M_TOUCH_SUR-
FACE_1x3_12.7mmx25.4mm
2 D1, D2 DIO TVS BIDIR PGB101 SMD | Littlefuse PGB1010402KR
0402
3 D3, D18, D21 DIODE SCHOTTKY 23V 1A ST Microelectronics BAT20JFILM

SOD323

Female 20-30AWG 6A TH R/A

Ltd.

2 D5, D6 DIO RECT 1N4148WS 1.25V | Diodes Incorporated 1N4148WS-7-F
150mA 75V SOD-323
FB1 FERRITE 2A 220R SMD 0805 | Murata BLM21PG221SN1D
2 FB2, FB3 FERRITE 2A 600R SMD 0805 | TDK Corporation MPZ2012S601AT000
1 J1 CON USB2.0 MICRO-B FCI 10118194-0001LF
FEMALE TH/SMD R/A
1 J5 CON TERMINAL 2.54mm 1x2 | Degson Electronics Co., |DG308-2.54-02P-14-00A

(H)

3 Jg, J13, J18

CON HDR-2.54 Male 1x2 Gold
5.84MH TH VERT

FCI

68000-202HLF

5.84MH TH VERT

4 J9, J10 SOCKET mikroBUS HOST Sullins Connector PPTCO081LFBN-RC
DIP 16 TH Solutions

1 J11 CON DSUB DE-9P Male TH Norcomp Inc. 182-009-113R181
R/A

3 J6,J12, J20 CON HDR-2.54 Male 1x3 Gold | FCI 68000-103HLF

SMD 10x10x3.8

2 J14, J15 CON HDR-2.54 Male 2x10 Sullins Connector PBC10DBAN
Rotated 180Degrees Gold TH | Solutions
RT ANGLE

2 J16, J22 CON TERMINAL 2.54mm 1x3 | On Shore Technology Inc | OSTVNO3A150
Female 20-30AWG 6A TH R/A

1 J17 CON HDR-2.54 Male 2x5 Gold | Amphenol ICC (FCI) 67997-210HLF
5.84MH TH VERT

1 J19 CONN HEADER VERT Samtec Inc. TSW-106-07-G-T
18POS 2.54MM

1 L2 INDUCTOR 47uH 1.85A 30% | Wirth Elektronik 744066470

DS70005531A-page 32
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Bill of Materials (BOM)

TABLE B-1:

dsPIC33C TOUCH-CAN-LIN DEVELOPMENT BOARD BOM (CONTINUED)

1 LED1

DIO LED TRI RED, GREEN,
BLUE 2.1V, 3.0V, 3.2V 50mA,
35mA, 35mA SMD 6-PLCC

Cree Inc

CLX6F-FKC-CNP1ST1E
1BB7D3D3CT-ND

6mcd Clear SMD 0603

2 LED2, LED3 DIO LED RED 2V 20mA Wirth Elektronik 150060RS75000
250mcd Clear SMD 0603
8 LED4, LEDS5, LEDS, DIO LED GREEN 2V 30mA Lite-On LTST-C190KGKT
LEDS8, LED10, LED11, | 35mcd Clear SMD 0603
LED12, LED14
2 LED15, LED16 DIO LED YELLOW 2.1V 20mA | Lite-On LTST-C190YKT

1 Q1 TRANS PREBIAS NPN 50V Nexperia USA Inc. PDTC114EU,115
SOT323

2 Q5, Q6 RF TRANS NPN 12V 11GHZ | NXP USA Inc. BFUS550WX
SOT323-3

6 R1, R2, R8, R11, R70, | RES TKF 10k 1% 1/10W SMD | Panasonic ERJ-2RKF1002X

R35, R36, R37, R56

SMD 0402

R159 0402
1 R3 RES TKF 442k 1% 1/16W Samsung Electro- RC1005F4423CS
SMD 0402 Mechanics
1 R4 RES TKF 95.3k 1% 1/16W Yageo ACO0402FR-0795K3L
SMD 0402 AEC-Q200
1 R5 RES TKF 24.3k 1% 1/16W Samsung Electro- RC1005F2432CS
SMD 0402 Mechanics
2 R6, R20 RES TKF 5.62k 1% 1/16W Vishay CRCWO04025K62FKED
SMD 0402
3 R7, R54, R55 RES TKF 470R 1% 1/16W MF | Yageo RC0402FR-07470RL
0402
2 R9, R24 RES TKF 31.6k 1% 1/10W Panasonic ERJ-2RKF3162X
SMD 0402
5 R10, R25, R29, R97, |RES TKF 47k 5% 1/10W SMD | Panasonic ERJ-2GEJ473X
R98 0402
6 R12, R17, R18, R19, |RES TKF 100k 1% 1/10W Panasonic ERJ-2RKF1003X
R71, R72 SMD 0402 AEC-Q200
5 R13, R14, R38, R39, |RESTKF 4.7k 1% 1/16W SMD | Yageo RC0402FR-074K7L
R74 0402
8 R15, R16, R30, R34, |RES TKF 330R 1% 1/16W Yageo RC0402FR-07330RL

15 |R21, R47, R52, R58,
R60, R62, R73, R76,
R81, R85, R113, R114,

R115, R116, R117

RES TKF 1k 1% 1/10W SMD
0603

Vishay, Panasonic

CRCWO06031K00FKEA,
ERJ-3EKF1001V

4 R26, R83, R88, R102

RES TKF 100R 1% 1/10W
SMD 0603 AEC-Q200

D1_Rohm Semiconduc-
tor

KTRO3EZPF1000

2 R27, R66

RES TKF 20R 1% 1/10W SMD
0603

Panasonic

ERJ-3EKF20R0V

3 R28, R32, R33

RES TKF 3.3k 1% 1/10W SMD
0402

Panasonic - ECG

ERJ-2RKF3301X

3 R31, R48, R111

RES TF 10k 1% 1/8W SMD
0603

Vishay Beyschlag, Vishay

MCT06030C1002FP500

2 R40, R41

RES TKF 22R 1% 1/10W SMD
0603

Yageo

RC0603FR-0722RL
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TABLE B-1: dsPIC33C TOUCH-CAN-LIN DEVELOPMENT BOARD BOM (CONTINUED)

1 R42 RES TKF 3.3k 1% 1/10W SMD | Panasonic ERJ-3EKF3301V
0603

4 R43, R87,R92, R110 |RES TF 2.2k 1% 1/10W SMD | TE Connectivity Passive | CRGCQO0603F2K2

0603 AEC-Q200

Product

74LVC1T45GM or
74LVC1T45GW Single Bit Volt-
age Translator SOT-886
SOT-363 Dual FP

1 R44 RES TKF 75R 1% 1/16W SMD | Yageo RC0402FR-0775RL
0402

5 R45, R57, R59, R61, |RES TKF 10k 1% 1/10W SMD | Panasonic ERJ-3EKF1002V

R77 0603

1 R46 RES TKF 8.2k 1% 1/10W SMD | Panasonic ERJ-3EKF8201V
0603

5 R49, R50, R112, RES TKF 330R 1% 1/10W Panasonic ERJ-3EKF3300V

R160, R161 SMD 0603

1 R51 RES TKF 180R 1% 1/10W Yageo RC0603FR-07180RL
SMD 0603

1 R53 RES VARIABLE 10k 20% TH | Bl Technologies / TT P090S-14T20BR10K
P090S Electronics

3 R67, R68, R69 RES TKF 56k 1% 1/16W SMD | ROHM MCRO1MZPF5602
0402

3 R78, R79, R84 RES TKF OR 1/10W SMD Panasonic ERJ-3GEYORO0OV
0603

1 R91 RES TKF 2k 1% 1/10W SMD | Panasonic ERJ-3EKF2001V
0603

2 R108, R109 RES TKF 68R 1% 1/10W SMD | Panasonic ERJ-3EKF68R0OV
0603

1 R118 RES TF 100k 1% 1/8W SMD | Yageo RT0603FRDO0O7100KL
0603

2 R120, R121 RES TKF 60.4R 1% 1/4W Yageo RC1206FR-0760R4L
SMD 1206

1 R122 RES TKF 2.7k 1% 1/10W SMD | Panasonic ERJ-3EKF2701V
0603

2 R150, R151 RES TKF 15R 1% 1/16W SMD | Stackpole Electronics Inc | RMCF0603FT15R0
0603

4 S1, S2, S3, S4 SWITCH TACT SPST 12V C&K Components PTS645SM43SMTR92
50mA PTS645SM43SMTR92 LFS
LFS SMD

1 u3 IC SWITCH SPDT Texas Instruments SN74LVC1G3157DCKR
74LVC1G3157 SC-70-6

3 ue, U7, U8 IC TRANSCEIVER Nexperia USA Inc. 74LVC1T45GM,132

Microchip Parts listed below

MCP1727-3302E/MF

1 U1 MCHP MCU16-BIT 1024KB Microchip Technology dsPIC33CK1024MP710-|
Flash, 128KB, /PT
dsPIC33CK1024MP710-I/PT
TQFP-100

1 u2 MCHP ANALOG LDO 3.3V Microchip Technology MCP1727-3302E/MF
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TABLE B-1:

dsPIC33C TOUCH-CAN-LIN DEVELOPMENT BOARD BOM (CONTINUED)

1 U4

MCHP MCU 32-BIT 300MHz
2MB 384kB
ATSAME70N21B-ANT
LQFP-100

Microchip Technology

ATSAME70N21B-ANT

MCHP MEMORY SERIAL
EEPROM 256k 12C
241.C256T-E/ST TSSOP-8

Microchip Technology

241L.C256T-E/ST

MCHP INTERFACE USB
I2C/UART MCP2221A-I/ML
QFN-16

Microchip Technology

MCP2221A-I/ML

1 u11

MCHP INTERFACE CAN
ATAG563-GAQW1 SOIC-8

Microchip Technology

ATAG563-GAQW1

1 u12

MCHP INTERFACE LIN
ATA663211-GAQW SO-8

Microchip Technology

ATA663211-GAQW

1 u16

MCHP ANALOG VREF 2.5V
MCP1525T-I/TT SOT-23-3

Microchip Technology

MCP1525T-I/TT

1 u17

MCHP ANALOG POWER
SWITCH 5.5V 3A
MIC2042-1YTS TSSOP-14

Microchip Technology

MIC2042-1YTS

1 u60

MCHP INTERFACE USB 2.0
HS 2 PORT HUB CTRLR
QFN-24 USB2422-I/MJ

Microchip Technology

USB2422-1/MJ

8.000MHZ MCHP CLOCK
OSCILLATOR SINGLE
DSC6011J11B-008.0000 VLGA

Microchip Technology

DSC6011J11B-008.0000

MCHP CLOCK OSCILLATOR
SINGLE 12.000MHZ
DSC6011J11B-012.0000 VLGA

Microchip Technology

DSC6011J11B-012.0000

MCHP OSC MEMS DSC6011-
JI2B-024.0000_2.5LX2.0WXO0.
89H_LGA

Microchip Technology

DSC6011J12B-024.0000

1 u14

IC Crypto Element SHA-256
1-Wire ATSHA204A-MAHCZ-T
UDFN-8

Microchip Technology

ATSHA204A-MAHCZ

Mechanical Parts to be added in the package

4 PAD1, PAD2, PAD3,
PAD4

MECH HW RUBBER PAD
Hemisphere D6.4 H1.9 CLEAR

3M

SJ5382

PCB

1 PCB1

Printed Circuit Board

04-11604-R2

Do Not Populate Parts listed below

3 | J12,_J18

MECH HW JUMPER 2.54mm
1x2

3M

969102-0000-DA

1 C50

CAP CER 15pF 50V 5% NPO
SMD 0603

Yageo

CC0603JRNP09BN150

3 C69, C71,C72

CAP CER 100pF 100V 5%
CO0G SMD 0603

KEMET

C0603C101J1GACTU

TH VERT

3 D7, D8, D9 DIO TVS PESD1IVN27-AX Nexperia USA Inc. PESD1IVN27-AX
45V 3A SOD-323
1 J2 CON HDR-1.27 Male 1x2 Gold | Digikey 952-3598-ND

© 2023 Microchip Technology Inc.

and its subsidiaries

DS70005531A-page 35



dsPIC33C Touch-CAN-LIN Curiosity Development Board User’s Guide

TABLE B-1: dsPIC33C TOUCH-CAN-LIN DEVELOPMENT BOARD BOM (CONTINUED)
1 J3 CON HDR-1.27 Female 1x8 Aceconn Technology FSEA120-0802A002B1A
TH VERT (Shenzhen) B
1 J4 CON HDR-2.54 Male 1x6 Sullins Connector Solu- | PBCO6SAAN
Staggered DNP tions
1 J7 CON TERMINAL 2.54mm 1x4 | On Shore Technology OSTVNO04A150
Female 20-30AWG 6A TH R/A |Inc.
1 J21 CON HDR-2.54 Male 1x2 Gold | FCI 68000-202HLF
5.84MH TH VERT
1 L1 CM CHOKE 5.1k@10MHz TDK Corporation ACT1210D-101-2P-TLOO
1.5R SMD 1210 AEC-Q200
2 R64, R65 RES TKF 15R 1% 1/16W SMD | Stackpole Electronics Inc | RMCF0603FT15R0
0603
4 R82, R107, R126, RES TKF 1k 1% 1/10W SMD | Vishay CRCWO06031KO0FKEA
R127 0603
2 R90, R104 RES TKF OR 1/10W SMD Panasonic RMCF0603ZTORO0
0603
1 R119 RES TKF 60.4R 1% 1/4W Yageo RC1206FR-0760R4L
SMD 1206
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